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Introduction

Photomatix Pro works with photographs of the same scene taken under different exposure settings, often called
“bracketed” images in reference to the auto-bracketing exposure functions available on many camera models. If
you have not taken bracketed photos, you can start using Photomatix Pro with the sample images available from
the download page of the Photomatix Pro website — http://www.hdrsoft.com. Use the information in Section
1, Taking Photos for HDR to try Photomatix with your own images.

This manual contains information about how to use Photomatix Pro to adjust images using different Tone
Mapping or Exposure Fusion methods. All of the methods are accessed from one window within the application,
making it easy to try different settings to achieve the results you want. Refer to Section 2, Loading and Pre-
Processing Images and Section 3, Adjusting Images Using Tone Mapping or Exposure Fusion for detailed
information about the different settings that are available.
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1 Taking Photos for HDR

The shooting phase is essential for getting good results with Photomatix.
To photograph a high contrast scene, you need to take several exposures in
order to capture information in both the highlights and the shadows of the
scene. The exposures taken must properly cover the dynamic range of the
scene, especially the shadows.

The number of photos you need depends on the scene. It also depends on
the Exposure Value (EV) spacing separating the photos. If you take them
in one-EV steps (e.g., -1, 0, +1 EV), you will need more photos than if you
take them in two-EV steps (e.g., -2, 0, +2 EV). We recommend shooting in
two-EV steps whenever possible.

High contrast scenes can be grouped into roughly two types depending on
their dynamic range:

« Medium dynamic range scene: Most landscapes and other types of
outdoor scenes fall into this category. Three exposures taken in two-EV
steps (i.e. -2, 0 +2 EV), or five exposures taken in one-EV steps, are usu-
ally sufficient for this type of scene.

- High dynamic range scene: A typical example is the interior of a room
with a view outside the window on a sunny day. You need to take at
least five exposures in two-EV steps (or nine exposures in one-EV steps)
to capture this type of scene, but you may need more. Taking the expo-
sures manually is recommended in these cases.

The source photographs for HDR processing can be taken with digital or
film-based cameras. The only requirement is that the exposure can be ad-
justed when taking pictures. If you use a film-based camera, you will need
to scan the photographs into your computer before processing them (refer
to Section 1.3).

1.1 Setting up the Camera

«  Setyour camera to Aperture priority (A setting) so only the shutter
speed varies between the exposures.

« Selectalow ISO, such as ISO 100 or lower.

«  Turn off the flash. The flash may try to balance the exposure of all the
images, when the goal is a range of exposures.

«  Mount the camera on a tripod whenever possible. Even though
Photomatix Pro offers automatic alignment of hand-held photos, using
a tripod is always better.

DSLR cameras and some compact digital cameras offer Automatic
Exposure Bracketing (AEB). This enables you to automatically take three
or more exposures in a row; one at the proper exposure, one or more
underexposed, and one or more overexposed. Follow these steps if your
camera offers AEB mode:
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+ Select the Continuous shooting mode on the camera’s drive setting.
Consult your camera manual for model-specific instructions for using
this setting.

+ Set the camera to Auto Exposure Bracketing (AEB)

« If possible, use the camera’s self-timer setting, or a cable release to mini-
mize camera shake.

+  Set the exposure increment to +/- 2 for optimal exposure range. If your AEB settings on a Nikon D80
camera does not offer +/- 2 exposure increments, select the maximum (3 shots with +/- 2EV)
possible. Consult the camera manual for model-specific instructions for
choosing this setting.

1.2 Selecting the Exposures @ Note

To get good results with HDR processing, your capture sequence must
include photos that correctly expose highlights and photos that correctly
expose shadows. The latter is especially important to prevent noise from
showing in the processed HDR image.

The continuous shooting mode may
not always be the best strategy be-
cause camera shake may build up.
It is recommended to use a method

In the lightest photo of the sequence, the darkest shadows should be at that ensures the least possible
least in the mid-tones. To check this, use your camera’s histogram preview shake for each single shot, such as
in playback mode. In your most overexposed photo, the left part of the mirror lock-up functionality, if
histogram should be empty until 1/3rd of the histogram’s width. If this is available.

not the case, add one or more photos taken with longer exposure times.

Another option is to re-shoot the exposure sequence with the normal

exposure set one or more EVs higher if your most underexposed image in

the exposure sequence was too dark. This is the case when the histogram

of your darkest image is completely empty on the right half.

The number of exposures needed depends on the dynamic range of the

scene, in addition to the exposure increment. For most outdoor scenes,

three exposures taken at +/- 2 exposure increments is sufficient, provided

the scene does not include the sun. However, for the interior of a room

with a bright view out the window, you will need at least five images taken

with an exposure increment of +/- 2, or nine images taken with an expo-

sure increment of +/- 1.

In scenes with extreme differences between light and dark details, you
should change the exposures manually to ensure you capture a wide
enough range to cover your scene.

1.3  Using Film-Based Cameras

«  Follow the camera setup listed at the top of Section 2.1 and the tips on selecting exposures in Section 2.2.
Keep in mind that you will not have the option of previewing the live histogram to determine your exposure
range.

« Scan film or slides, not prints. Photo labs attempt to make the best print from each of your source images,
and you will not achieve good results scanning these for HDR generation.

«  Turn off your scanner’s auto-exposure options. This allows you to manually control the exposure.

«  Make sure you select the Align images option in Photomatix Pro when combining your images.
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2 Loading and Pre-Processing Images

This section describes how to load and merge bracketed image files of a

scene taken under different exposure settings as well as how to load single

images into Photomatix Pro.

2.1 Merging Bracketed Images

Photomatix Pro merges bracketed images that are in 8 bit or 16 bits/chan-

nel mode, as well as Camera RAW files.

Supported file types include JPEG, TIFF, PSD, DNG, and RAW files from

many camera models. The list of supported camera models for RAW files
changes frequently. You can check the the Photomatix Pro FAQ page on
the HDRsoft website at http://www.hdrsoft.com/support/raw.html to

determine whether or not your camera model is supported.

2.1.1

Loading Bracketed Images

To load bracketed image files, do one of the following:

Drag and drop the files into Photomatix Pro

Use the Workflow Shortcuts area or the File menu to load the files

Dragging and Dropping Bracketed Image Files

To drag and drop a group of image files to Photomatix Pro:

Windows: Drag the files from Windows Explorer and drop them on the
open Photomatix Pro program.

Macintosh: Drag the files from the Finder and drop them on the Photo-
matix Pro icon on your Dock.
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The term “bracketed images” refers
to images of the same scene taken
under different exposure settings.
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applies to the case when you have
not used the Automatic Exposure
Bracketing function of the camera to
take the exposures.

Drag the image files for the
exposure sequence at the same
time, so the files are properly
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If you have Lightroom, use the
Lightroom Export Plug-in to load
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Using the Workflow Area or the File Menu

To load images using the Workflow Shortcuts Area or the File menu:

1. Click Load Bracketed Photos in the Workflow Shortcuts area

OR
Select Load Bracketed Photos from the File menu.

The Select bracketed photos dialog displays.

- :
a Generate HDR - Selecting source images - M

Select image files taken under different exposures.
Either use the "Browse..." button or drag files below.

Browse...

[ Show intermediary 32-bit HDR image

Selecting bracketed photos

2. Dragand drop the files into the Selecting bracketed photos dialog

OR
Click Browse. A dialog displays prompting for location of the files.

3. Select the files to load, using one of the following methods:

«  Click the first file, hold down control key (Windows) or command
key (Mac) and click the last file

«  Click the first file, hold down shift key and click each file
4. Click Open (Windows) or Select (Mac).
Click OK to pre-process the files.

Entering Exposure Values

If the exposure information cannot be located in the metadata of the
image files, Photomatix Pro displays a dialog prompting for input of the
relative Exposure Values for each image. Photomatix Pro also displays this
dialog if two or more source images share the same exposure information.
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2.1.2 General Pre-Processing Options

After the bracketed images are selected, the pre-processing settings for the images may be customized before
the 32-bit HDR image is generated. Refer to the following list for a description of the available options for merg-
ing bracketed images:

Alignment Options preproce-sion Crtigl 5]
[¥ Align source images [¥ Crop aligned images
The Align source images option is checked by default. It corrects - ?.:..‘T;:m“ and vertical shifs
misalignment problems when the camera moves slightly between the
bracketed frames. Hand-held photographs and even some images shot - e astng e [
with a tripod have camera movement. © stomac  petecsons| Hioh
+ By correcting horizontal and vertical shifts: Faster method, but only i noiee oot o
corrects for translation movements. s b
- By matching features: Corrects for rotation and translation. Recom- |
mended for hand-held shots. i ann
+ Crop aligned images: Checked by default. Removes the unused '
borders that appear when the images are shifted to correct for mis- =
registration. Leave this box unchecked if you need the resulting image Selecting pre-processing options

to have the same width and height as the source images.

The Reduce ghosting artifacts option addresses the problem of artifacts ~ The deghosting option is effective
that appear when combining images of a dynamic scene. For example, if for images processed with Tone

the moving subjects are people walking, the persons show multiple times
in the combined image as if there were “ghosts”. This is why artifacts arising
from movements in the scene are commonly referred to as “ghosting” and

Mapping or with the default
Exposure Fusion method. It is not
effective for the other Exposure
Fusion methods.

the attempt to eliminate them as “deghosting”

Semi-manual: select the ghosted regions and change the image used for deghosting the selected region.
Refer to Section 3.1.3 for more information about the tool.

Automatic: have Photomatix Pro automatically detect ghosted zones in the merged image and select a
Detection level, Normal or High. This sets the criteria for determining if a pixel is or is not ghosted when
using automatic deghosting.

Noise Reduction Options

The Reduce noise option reduces chromatic and luminance noise and is recommended when processing RAW
files directly in Photomatix.

Strength: Increase or decrease the strength of the noise reduction relative to the automatically determined
value based on the noise level in the image. Values range from 50% to 150%.

On source images: Apply noise reduction on the source image files. Use the associated drop-down list to
select the image types to apply noise reduction to. This option takes more time, but yields better results.

On merged image: Apply noise reduction on the merged image once it has been created. Note that the
noise reduction algorithm is different when applied on the merged image. It is recommended to apply the
noise reduction on the source images.

The Reduce Chromatic Aberrations option automatically corrects color fringing due to chromatic
aberrations of the lens. Checking this option is recommended, given that chromatic aberrations tend to show
around high contrast edges, and are particularly an issue for HDR images.
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2.1.3 Using the Selective Deghosting Tool

The Selective Deghosting Tool lets you select the portions of the image that require processing for removing
ghosting due to the movement of the subject. Photomatix Pro uses the image that it deems the best exposed for
the selected area as the default image for deghosting. You may change the image to one of your choice using the
tool.

Select Semi-manual from the Reduce ghosting artifacts preprocessing options to access the Selective deghosting
tool. To use the Selective Deghosting tool, click and drag the mouse to draw a line around the region that requires
deghosting. Ensure the selection is a fully closed loop with a dashed line.

Semi-manual deghosting

Right-click (Windows) or control-click (Mac) inside the selected region and select Mark selection as ghosted area
from the pop-up menu. The line around the selected region changes from dashed to solid to indicate that the area
has been selected for deghosting.

Mark selection as ghosted area

Remove selection

At any time, use the Brightness slider to increase or decrease the brightness of the image. Or, use the Zoom slider
to zoom in and out.

If necessary, you can remove a region from the deghosting selection. Control click or right click inside an already
marked region and click Remove selection from the pop-up menu.
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You may also change the image used as the default image for deghosting.
Control-click or right-click inside an already marked region and click Set an-
other photo for selection from the pop-up menu. The tool displays a pop-
up menu with a list of the available exposures. Select an exposure value
from the list.

Mark. selection as ghosted area

Remove seleckion

Set another photo for selection »

-2 EV phota

0 EY photo

+2 EV photo

To view a preview of the deghosted image, click Preview deghosting.

To make more selections or modify existing regions selected for deghost-
ing, click Return to selection mode. You may continue selecting regions of
the image and previewing the results until you are satisfied with the results.

Click OK to apply the deghosting to the image or click Cancel to stop merg-
ing the images.

2.1.4 Pre-Processing Options for RAW Files

Photomatix Pro offers additional pre-processing options for RAW files. The
White Balance drop-down list includes the following selections:

« As Shot - default value. Reads the white balance from the EXIF meta-
data

« To adjust the white balance, select a pre-defined value from the White
Balance drop-down list or specify the color temperature in Kelvin

Click Preview sample to view the effect of the white balance change on
the source image.

The Color primaries HDR image drop-down list provides options for con-
verting the RAW data from the camera native color space to the display pro-
file of the selected value. AdobeRGB is the default value and is appropriate
when you want to print the resulting image. If you would like to display the
resulting image only on the web and do not intend to print it, then select
sRGB to avoid having to convert the image from AdobeRGB to sRGB.
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2.2 Working with Single Image Files

Photomatix Pro supports Tone Mapping of single image files. To load a single
image file:

1. Drag the image file to the Photomatix Pro application (Windows) or icon
on your Dock (Mac).
OR
Select Open from the File menu. A file browser window displays.
Navigate to the file and open it.

2. To process the image using Tone Mapping, click Tone Mapping from the
Workflow Shortcut bar.

If the file is a JPG, a dialog will show to let you decide whether to
reduce the noise on your image before tone mapping. If desired,
check Do not ask me again to skip this dialog and use your Yes
or No selection for all single JPGs that you process with Tone
Mapping. If you need to re-enable the dialog later, access the
Photomatix preferences on the View menu to change the setting.

2.2.1 Options for Single RAW Image Files

When your single image is a RAW file, Photomatix must first convert the RAW
data. The following options are available for pre-processing the RAW data.

The Reduce noise option reduces chromatic and luminance noise. It is
checked by default as reducing noise is always recommended when process-
ing RAW files. The Strength slider lets you increase or decrease the strength
of the noise reduction relative to the automatically determined value based
on the noise level in the image. Values range from 50% to 150%.

The Reduce chromatic aberrations option automatically corrects color
fringing due to chromatic aberrations of the lens.

The White Balance drop-down list includes the following selections:

« As Shot - default value. Reads the white balance from the EXIF meta-
data

« To adjust the white balance, select a pre-defined value from the White
Balance drop-down list or specify the color temperature in Kelvin

Click Preview sample to view the effect of the white balance change on the
source image.

The Color primaries HDR image drop-down list provides options for to con-
verting the RAW data from the camera native color space to the display pro-
file of the selected value. AdobeRGB is the default value and is appropriate
when you want to print the resulting image. If you do not intend to print
the image, select sRGB for web-only images to avoid having to convert the
image from AdobeRGB to sRGB.
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3  Adjusting Images Using Tone Mapping or Exposure Fusion

Photomatix Pro provides access to HDR Tone Mapping and Exposure Fusion
methods in one window. The window includes a preview, so you can see
how adjustments to settings or changing the adjustment method affect
the result. This section describes the workflow for adjusting and processing
images and details the Tone Mapping and Exposure Fusion settings.

3.1 Image Adjustment Workflow

After you have preprocessed and merged your source images (or opened a
single image file), the next steps are:

1. Adjust the image to your liking: Photomatix Pro offers different Tone
Mapping and Exposure Fusion methods. Most methods offer different
adjustment settings. Refer to Sections 3.3 through 3.6 for detailed
descriptions of the settings.

You can use presets for easier image adjustment. Refer to Section 3.2.2
for more information about using presets.

2. Process theimage: When you are satisfied with the adjustments, click
on the Process button located at bottom of the Adjustment window to
process the image at original resolution with the selected settings.

3. Save the image: When you have processed the image, you can save it.
Select File - > Save As. Navigate to the folder where the file should be
stored. Use the default file name or enter a name in the File name field.
Select a file type:

«  TIFF - 16bit: best choice for further processing

«  TIFF - 8bit: for use in applications that cannot work with 16 bit, or
for avoiding too large a file size on disk

« JPEG: for use on the web without further editing

If you would like to view the file with a photo viewing application, you can
click Open Saved Images with. Accept the default program or select the
program from the drop-down list. If the program is not on the list, click
Add application, navigate to the folder containing the program, select the
program and click Open.
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when bracketed photos were
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is loaded only tone mapping is
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To undo changes made during
the adjustment process, click
the undo arrow at the bottom of the
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To redo adjustments, click the
redo arrow to reapply changes.

o

The settings are automatically embed-
ded in the saved processed image. To
view the settings, click View Settings
from the Workflow Shortcuts bar.
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Undoing Adjustments and Reprocessing an Image

After processing an image, you can return to Tone Mapping or Exposure Fusion to make further changes if you
are not satisfied with the results.

You may undo processing using one of the following methods:

« Select Undo Tone Mapping or Undo Exposure Fusion from the Process menu. Photomatix Pro returns the
image to its original state.

«  Click Tone Mapping/Fusion from the Workflow Shortcut bar or select Tone Mapping/Fusion to return to the
image adjustment window.

3.2 Image Adjustment Windows

3.2.1 Preview Window For the Details Enhancer method of
Tone Mapping and the Adjust method

The Preview Window provides a preview of the tone mapped or fused of Exposure Fusion, the preview is not

image as you adjust the settings, as well as the following controls. always an accurate representation of
the final tone mapped image.

B Fzfresh loupz only

B Refresh on deman

Previewing image adjustments

» Size Ratio: The radio buttons at top of the Preview dialog may be used to select the preview size related to
the size of the original. For instance, 1/4 displays the preview one quarter the size of the original image.

e Zoom: The Zoom slider scales the selected size by a percentage.

« Preview: The Preview checkbox quickly toggles between a preview of the tone mapped image (the default)
and the original image. Use this to compare the effects of the changes with the original.

« Floating Histogram: The tone mapping Histogram is a floating window that contains four selectable tabs to
improve analysis of the image: Luminance, Red, Green, and Blue. In addition, move the mouse back and forth
across the histogram to display Level, Count, and Percentile information. If the histogram is turned off, enable
it by selecting 8-bit Histograms from the View menu.
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3.2.2 Preset Thumbnails Panel

The Preset Thumbnails area provides access to built-in settings, each with its own corresponding thumbnail im-
age. The built-in presets are “factory” settings showing various effects. The thumbnails provide a way to quickly
view the effect of the settings on the image.

Preset Thumbnails - venice.[z]  1he following built-in presets are available:

“| « Enhancer - Default: Default settings for De-
tails Enhancer.

o Compression - Default: Default Tone Com-
pressor settings.

o Fusion - Default: Default settings for Fusion
Adjust.

«  Enhancer - Smooth: Effect that produces a Enhancer - Default example
smooth image by avoiding too much contrast
enhancement in the highlights, which is use-
ful, for instance, to prevent a blue sky from
turning dark grey-blue.

m
.

Compression - Deep: darker, more com-
pressed Tone Compressor settings that result
in an image with more pronounced colors.

«  Enhancer - Painterly: See second image on
the right. Enhancer - Painterly example

- Enhancer - Grunge: See third image on the
right.

« Enhancer - B&W: Monochrome image, which
is achieved by setting the Color Saturation to
zero

«  Fusion - Adjusted: Default Exposure Fusion
£ method with adjusted settings

«  Fusion - Auto: Quick access to Fusion Auto,
as opposed to selecting Exposure Fusion and
Auto.

Enhancer - Grunge example

«  Fusion - 2 Images: Default Fusion 2 Images
options.

- Fusion - Intensive: Default Fusion Intensive
settings

To use built-in presets, click Built-in on the Preset Thumbnails panel. The thumbnails
display with a label describing the preset. Click the desired thumbnail to refresh the pre-
view image and view the results.

“|  You may also access custom presets that you have saved when adjusting your images
(refer to Saving Custom Presets below for more information on how to save these). To
use the custom presets, click My Presets on the Preset Thumbnails panel.

Using the Preset
Thumbnails Panel to  To toggle the orientation of the Preset Thumbnails panel between horizontal and
Adjust an Image vertical, select Toggle Preset Thumbnails Orientation from the View menu. To toggle
(shown in vertical display of the Preset Thumbnails panel, select View Preset Thumbnails from the View
mode) menu.
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Saving Custom Presets

There are two ways to save custom presets as an XMP file for future use;
during the image adjustment phase or after Tone Mapping or Exposure
Fusion is complete.

To save custom presets during image adjustment:
1. In the Adjustments panel, click the Presets drop-down list.
2. Select Save Settings from the list.
3. Enter a name for the preset in the File name field and click Save.

To save the processing selections as a preset after Tone Mapping or Expo-
sure Fusion processing:

1. Click Save Settings from the Workflow Shortcuts bar or select Save
Settings from the File menu. A dialog prompts for the file name.

2. Enter the file name and click OK.
3.3 Tone Mapping Details Enhancer Settings

General Settings

«  Strength: Controls the strength of the contrast enhancements. Move the slider
right or left to change the setting. A value of 100 gives the maximum increase
in both local and global contrast enhancements. The default value is 70.

«  Color Saturation: Controls the saturation of the RGB color channels. The
greater the saturation, the more intense the color. Move the slider right or left
to change the setting. A value of 0 produces a grayscale image. The value af-
fects each color channel equally. The default value is 46.

«  Luminosity: Controls the compression of the tonal range, which has the effect
of adjusting the global luminosity level. Move the slider to the right to boost
shadow details and brighten the image. Move it to the left to give a more
“natural” look to the resulting image. The default value is 0.

«  Microcontrast: Sets the how much local details are amplified. A higher value
gives a sharper look. The default value is 0.

« Smoothing: Controls smoothing of the contrast variations throughout the
image. This setting has an important influence on the look of the tone mapped
image. High values give a more “natural” look, low values a more “artificial” or
“painterly” look.

«  Light mode: Smoothing is available in two modes. The default mode is a slider.
If the slider is not visible, uncheck Light mode in the Smoothing section. The
“Light” mode takes the form of labeled buttons and can be accessed by check-
ing “Light mode”. The effect on the image differs depending on the mode. The
“Light” mode tends to produce a more “surreal” effect. Note that a different
algorithm is used depending on the mode.
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If you save the preset in the default
location (which is the Presets folder
of the Photomatix Pro application),
the preset is automatically added
to the Presets combo-box list, and
also shows on the “My Presets” tab
of the Preset Thumbnails Panel.

Strength 70
A
Color Saturation 45
5

Luminosity 0.0
7%

Microcontrast 0.0
A

Smuoaothing 0.0
N

[ Light mode
Tone Mapping Details

Enhancer General Settings
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Tone Settings

White Point — Black Point: Both sliders control how the minimum and
maximum values of the tone mapped image are set. Moving the sliders
to the right increases global contrast. Moving them to the left reduces
clipping at the extremes. The White Point slider sets the value for the
maximum of the tone mapped. The Black Point slider sets the value for
the minimum of the tone mapped image. The default value is 0.25% for
the White Point setting and 0% for the Black Point setting.

Gamma: Adjusts the mid-tone of the tone mapped image, brightening or
darkening the image globally. The default value is 1.0.

Color Settings

Temperature: Adjusts the color temperature of the tone mapped image rela-
tive to the temperature of the HDR source image. Move the slider to the right
to give a warmer, more yellow-orange colored look. Move the slider to the
left for a colder, more bluish look. A value of 0 (default) preserves the original
color temperature of the HDR source image.

Saturation Highlights: Adjusts the color saturation of the highlights relative
to the color saturation set with the Color Saturation slider. Values higher than
0 increase the color saturation in the highlights. Values lower than 0 decrease
it. The default value is 0.

Saturation Shadows: Adjusts the color saturation of the shadows relative to
the color saturation set with the Color Saturation slider. Values higher than
zero increase the color saturation in the shadows. Values lower than zero
decrease it. The default value is 0.

Miscellaneous Settings

Micro-smoothing: Smoothes local detail enhancements. This has the
effect of reducing noise in the sky, for instance, and tends to give a
“cleaner”look to the resulting image. The default value is 2.

Important note: The Loupe may not properly show the effect of the Micro-
smoothing setting when the area magnified is uniform. If you want to see
the effect of the Micro-smoothing setting at 100% resolution on a uniform
area such as the sky, you will have to select an area that contains an object

in the scene in addition to the sky.

Highlights Smoothness: Reduces the contrast enhancements in the
highlights. The value of the slider sets how much of the highlights
range is affected. This control is useful for preventing white highlights
from turning grey or uniform light blue skies becoming dark blue-grey.
It is also useful for reducing halos around objects placed against bright
backgrounds. The default value is 0.
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Shadows Smoothness: Reduces the contrast enhancements in the
shadows. The value of the slider sets how much of the shadows range is
affected. The default value is 0.

Shadows Clipping: The value of the slider sets how much of the shad-
ows range is clipped. This control may be useful to cut out noise in the

dark area of a photo taken in a low-light situation. The default value is 0.

360° image: Checking this option eliminates the seam between the
left and right sides of a panorama viewed in a 360° panoramic viewer.
The seam would otherwise show because Details Enhancer takes into
account local contrast, assigning different tonal values to the right and
left parts of the image. The default value is unchecked. Note that this
option is not enabled when the image is in portrait mode, as the option
is intended for panoramas.

3.4 Tone Mapping Tone Compressor Settings

Brightness: Adjusts the overall brightness of the tone mapped image.
The default value is 0.

Tonal Range Compression: Controls the compression of the tonal
range. Move the slider to the right to shift both shadows and highlights
toward the mid-tones in the tone mapped image. The default value is 0.

Contrast Adaptation: Adjusts the influence of the average brightness
in relation to the intensity of the processed pixel. Move the slider to the
right to create more pronounced colors. Move the slider to the left to
create a more “natural” look. The default value is 0.

White Point - Black Point: Both sliders control how the minimum and
maximum values of the tone mapped image are set. Moving the sliders
to the right increases global contrast. Moving them to the left reduces
clipping at the extremes. The White Point slider sets the value for the
maximum of the tone mapped image (pure white, or level 255). The
Black Point slider sets the value for the minimum of the tone mapped
image (pure black, or level 0). The default values are 0.

Temperature: Adjusts the color temperature of the tone mapped im-
age relative to the temperature of the HDR source image. Move the
slider to the right for a warmer, more yellow-orange colored look. Move
it to the left for a colder, more bluish look. A value of 0 (default) pre-
serves the original color temperature of the HDR source image.

Saturation: Adjusts the color saturation of the tone mapped image.
The greater the saturation, the more intense the color. The value affects
each color channel equally. The default value is 0.

Photomatix Pro User Guide
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3.5 Exposure Fusion Adjust Settings

«  Accentuation: Adjusts the strength of local contrast enhancements.
The default value is 0.

- Blending Point: Adjusts the weighting given to the underexposed
versus overexposed images. When you move the slider to the right,
overexposed images are favored, which has the effect of brightening
the image. The reverse applies when you move the slider to the left.
The default value is 0.

«  Shadows: Adjusts the brightness of the shadows without affecting the
highlights. The default value is 0.

- Color Saturation: Adjusts the saturation of the color channels. The
greater the saturation, the more intense the color. A value of 0 produc-
es a grayscale image. The default value is 0.

- White Clip: Specifies how much the highlights are clipped. Move the
slider to the right to increase contrast and remove details in the bright-
est highlights. The default value is 0.

- Black Clip: Specifies how much the shadows are clipped. Move the
slider to the right increase contrast but remove details in the darkest
shadows. The default value is 0.

Exposure Fusion Adjust Settings

«  Midtone: Positive values brighten the image but reduce the overall
contrast. Negative values darken the image but increase overall con-
trast. The default value is 0.

+ 360° Image: Checking this option eliminates the seam between the
left and right sides of a panorama viewed in a 360° panoramic viewer.
The seam would otherwise show because Fusion Adjust takes into ac-
count local contrast, assigning different tonal values to the right and
left parts of the image. The default value is unchecked.

3.6 Exposure Fusion Intensive Settings

«  Strength: Adjusts the strength of local contrast enhancements. The
default value is 0.

- Color Saturation: Adjusts the saturation of the color channels. The
greater the saturation, the more intense the color. A value of zero pro-
duces a grayscale image. The default value is 0.

- Radius: Controls the area used to calculate the weighting of the source
images. A higher radius reduces halos, but significantly increases pro- Exposure Fusion Intensive Settings
cessing times. The default value is 40.
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4  Automating with Batch Processing

Use batch processing to automatically process image files. The batch processing tool saves time processing many
images. Photomatix Pro offers two different batch modes:

« Batch Bracketed Photos: Processes bracketed sets using HDR Tone Mapping and/or Exposure Fusion all in
one step, which can save you a lot of time when you have many series of photos to process.

« Batch Single Photos: Processes single image files using Tone Mapping.

4.1 Batch Processing Bracketed Photos

This section describes batch processing photos taken under multiple exposure settings.

3 Batch Processing of differently exposed imag_ h L =1 éj
@ Generate HOR image
[¥ Tone map with Details Enhancer
[ Tone map with Tone Compressor | Setting |

¥ Fuse exposures with H&S - Adjust

[ Fuse exposures with H&S - Auto

[ Average
[ Fuse exposures with H&S - Intensive | Settings... |
@ select| 3 3 | images at a time  Advanced

Batch will take 3 of the files in the source list ‘ Optians... |
and process them with the above options _

[ Align source images [ Crop aligned output
" By comecting shifts | Save eligned output

® By matching features

Source Destination
Selectionby: (= F"'f"f' Select Folder... @ Created in source folder [ 1n each one of the subfolders
. Individualfiles —
 Custom location | Choose... |
IMG_8451.CR2 - —_—
IMG_8452.CR2 [
IMG_8453.CR2
IMG_8454 CR2 e P —
IMG_2455.CR2 Save final result as | 8-bit JPEG 5 | IPEG Quality:| 100 E|:
IMG_8456.CR2
IMG_8457.CR2 = Save 32-bit HDR.image as  Radiznce RODE g
EomaNchis Filter by: | paw & [ Remove 32-bit HDR image after Tone Mapping

Batch Processing of bracketed photos

4.1.1 Using Batch Processing

To batch process photos, select Batch Processing from the Automate menu or click Batch Processing from the
Workflow Shortcuts panel.

To batch process series of bracketed photos, do the following:
1. Click the checkboxes on the left side of the window to select how the images should be processed.

2. Select the number of exposures to combine using the pull-down menu below the checkboxes. For example,
select“3"if your bracketed shots consist of three exposures each, such as when you have taken for each scene
one photo at median exposure, one underexposed and one overexposed.
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6.
7.

In the Source area, select the folder where the bracketed photos are located. The files are arranged in
alphabetical order. N files at a time are processed with N being the number specified in the previous step.

To save the results in a different folder than the folder containing the source photos, select the Custom
location option in the Destination area at the bottom right of the window.

Accept the default of Created under source folder to create a subfolder with the name PhotomatixResults

in the source image folder.
In the Destination area, select the output file type.

Click Run to start batch processing.

While the batch is running, the results display in the area below the Run button.

4.1.2 Batch Processing Settings

Use the Settings buttons to access HDR generation, Tone Mapping, and Ex-
posure Fusion settings. Refer to Sections 3 and 4 for a description of these
settings.

The following settings for generating HDR images are specific to batch
processing:

Force Exposure Values spacing to: Forces the EV spacing to the speci-
fied value. This option can be used when the exposure information is
not available in the EXIF data, if two or more images have the same
exposure information, or to force the EV spacing in all cases. In the lat-
ter case, the exposure information in the EXIF data is ignored.

Source images are linear (no tone curve applied): Intended for
16-bit TIFF files that have been converted from RAW files with a RAW
converter that allows the image to be left in linear space. Very few
RAW converters allow this, so only check this option if you are sure that
the tonal values of the images are linear relative to the values of light
captured.

Process strip by strip: Check this option if the source images are large
TIFF files. With this option, the HDR image file is created in several pass-
es, processing and loading only one strip of each image into memory
at a time. One strip is composed of a limited number of rows set to not
exceed approximately 512 MB of RAM. This option is particularly useful
when processing large panoramas. Note, though, that the alignment
functions are not accessible when the “Process strip by strip” option is
used.
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Generate HDR image settings

The term “linear” may have a
different meaning depending on
the RAW converter. For example,
in Adobe Camera RAW, linear is
relative to the Adobe RGB color
space and not to the values of light.
Therefore, do not select this option
with files converted with Photoshop
or Lightroom.
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4.1.3 Batch Processing Subfolders

When your bracketed series are located in multiple folders, they can all be
processed in one run, provided they are in subfolders of the same parent
folder. To batch process multiple subfolders, check the Process subfolders
option at bottom of the Source frame on the Batch Processing dialogand - htained in the main parent folder
select sequentially. When “Process subfolders sequentially”is selected, for this option to work properly.

the batch will process the bracketed image files in one subfolder and then

move on to the next subfolder, all of which are contained in the main

parent folder.

All of the subfolders must be

Processing Series of Photos with Varying Numbers of Exposures

When your bracketed sets are composed of varying numbers of exposures, you can use “Process subfolders
sequentially” to combine the exposures in these sets in one batch run. Place each set in a separate subfolder,
group the subfolders under a parent folder, select Process subfolders sequentially and select All from the pull-
down menu for the number of images to process at one time.

Grouped by Exposures Option

If you are processing bracketed photos that will be part of a panorama, you may find it useful to be able to
organize your photos in such a way that all exposures of the same levels are in the same folder. Let’s take as an
example a panorama composed of four views that need to be stitched, with each view having been taken under
three exposures: -2, 0, +2. You will then have 12 photos, and may need to place them in three separate subfolders
composed of four photos each as follows:

«  Subfolder1 contains the four photos for the panorama taken at EV -2
«  Subfolder2 contains the four photos for the panorama taken at EV 0
«  Subfolder3 contains the four photos for the panorama taken at EV +2

If you check “Process subfolders” and select “grouped by exposures’, the batch will combine the first file of
Subfolder1 with the first file of Subfolder2 and the first file of Subfolder3. The batch will then combine the second
file of Subfolder1 with the second file of Subfolder2 and the second file of Subfolder3, and so on for the third and
fourth file of each subfolder.

4.1.4 Advanced Options S Oy =
@ Automatically detect numberof bracketed frames

The following items are accessed when you click Advanced and click S and [5 2] frames

Options to configure automatic selection of bracketed image files. 7 Bracketed sets may have an even number of rames

Click Automatically detect the number of bracketed frames when Maxin_umm i — bm;kgzcﬁes

processing a folder that contains files in addition to those in the set . select only part of the frames in bracketed set

of bracketed frames or when the number of frames in the set varies. bracketed sets have (RN frames each, but procees only

Photomatix Pro uses the metadata from the image files to perform S

automatic detection. Sccond Frame

Fourth Frame
Last Frame

«  Specify a range using the two drop-down lists to automatically detect
This option is useful when some of the photes in the processed folder are
the number Of braCketEd frames. not part of a bracketed set and/or when the number of frames per

bracketed set varies.
Note that the automatic detection is based on the metadata information

- Move the Maximum time between two bracketed frames slider right e bracheted ot PocE been e i Aot
. . . Exposure Eracketing and when the EXIF data have not been removed.
or left to allow more or less time (read from the metadata). Min is 2

second and max is 64 seconds.

Advanced batch processing options
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Click Select only part of the frames in bracketed set to load only selected frames from a bracketed set.

Specify the total number of frames in each set using the drop-down list.

Select the specific frames to process from the list. Select more than one file by holding down the Ctrl key

and clicking on the desired frames.

4.2 Batch Processing Single Image Files

Photomatix Pro supports processing of single image files using tone mapping.

To batch process single image files:

1.

Click Batch Single Files from the Workflow Shortcut bar
or select Batch Single Files from the Automate menu.

To select the source folder that contains the files, click
Select Folder.

Navigate to the folder that contains the files and click OK.
Photomatix Pro displays the folder/path and the files in
the folder.

To narrow down the files to process, if needed, hold down
the Ctrl key and click the files to process.

To process using the details enhancer, click Tone Map
with Details Enhancer. Click Settings to customize how
the files are processed.

To process using the tone compressor, click Tone Map
with Tone Compressor. Click Settings to customize how
the files are processed.

Click the checkboxes for noise and CA correction, if
needed.

To select a destination folder, click Created under Source
Folder to save the images in the same folder as the
source files

OR

Click Customized Location to save the images in a dif-
ferent folder. Click Choose to select the destination
folder. Photomatix Pro displays the folder location.

For JPG file output, select the quality from 0 to 100 from
the drop-down list, with 100 yielding the largest file size.

10. Click Run. The batch processing status displays.

21 Batch Tone Mapping of Single Photos

Source

Select Folder...

|C images\Canon 70

IMG_0025CR2 -
IMG_0044.CR2 @
IMG_0046 CR2 =
IMG_0047 CR2
IMG_0048 CR2
IMG_0049.CR2
IMG_0050.CR2
IMG_0051.CR2 il

Allfiles listed onthe right will be processed, unless you
select specific files with your mouse.

{If you rather wish o tona map ane photo with a praview to adjust
e ey e e o)

Processing Options

¥ Tone map with Details Enhancer

T Tone map with Tone Compressor Settings ...

¥ Reduce noise before tone mapping ey 100%

¥ Reduce chromatic aberrations before tone mapping

With raw files, set White Balance to  As Shot ¥ | Color Space to | ProPhoto RGB 3

[ Remove Photomatix' watermark from images created when Photomatix Pro was in trial mode

Run

(& Created under Source Folder ~ C Customized location | Choose...
|C:\images\Canon 7D'\PhotomatixCorversions01

Save tone mappedimage as | 8-bit IPEG & IPEG Quality: 5[)E|:
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is intended for automating the
processing of a lot of photos. To
process a single image file, load the
image file using the information in
Section 3 and Section 4.
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5 Tips and Techniques

This section provides tips for working with images in Photomatix Pro. More
tips and techniques, and regularly updated information, can be found on
the Photomatix Pro FAQ on the HDRsoft website at http://www.hdrsoft.
com/support/faq_photomatix.html.

5.1 Integrating Lightroom with Photomatix Pro

You can export photos for processing in Photomatix Pro directly from
Lightroom and reimport them back into the Lightroom library.

The Lightroom Export plug-in to Photomatix is free and included with the
Photomatix Pro package. Please refer to the HDRsoft website at http://
www.hdrsoft.com/download/Irplugin.html for installation instructions
and a short tutorial showing how to use the Lightroom export plug-in for
HDR processing in Photomatix Pro.

5.2 Processing RAW files in Third-Party RAW
Converters
When using a third-party RAW converter, develop the RAW images with the

following settings. As an example, the screenshots show the settings in
Lightroom:

Auto

0.00

Basic Settings in Lightroom

«  White Balance: Use the same white balance for all source photos.

« Basic settings: Set all to zero. It is particularly important to set the
Blacks setting to zero.

«  Curves: Parametric and Point Curves should be linear.

+ Details: Set the Sharpening Amount to zero

Photomatix Pro User Guide

To remove the watermark,
Photomatix Pro requires that the
image was not retouched after the
watermark was added to it. If the
brightness or contrast of the image
was changed, or the image was
cropped or resized, then Photomatix
will not be able to remove the
watermark.

Working with curves in Lightroom
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5.3 Dealing with Noise

When you process your photos using Exposure Fusion, the fused image will tend to show less noise than the
source images. This is because Exposure Fusion works by directly combining your bracketed photos, thus
averaging out noise. However, when you create a 32-bit HDR image, your bracketed photos are assembled in
linear space into an image that spans the full range of luminance values captured by the camera. If the lightest
photo of your exposure sequence is not bright enough to expose the shadows of the scene, then the noise in
the source photographs will be transferred to the HDR image. Noise in the HDR image will then be made more

apparent by tone mapping, especially with Details Enhancer as this tone mapping method increases local details.

Though Photomatix Pro includes options to reduce noise, it is still always better to avoid noise at capture time as
much as possible. There are two tips to ensure a low noise level:

« Tip 1:Set a low ISO setting (ISO 100 or lower) whenever possible
- Tip 2: Overexpose sufficiently, ensuring that the lightest image of your exposure sequence has its shadows in

the mid-tones.

5.4 Photomatix Pro and Color Management

Photomatix Pro supports color management even if RAW files are processed. You should use the same working
space in Photomatix Pro as you use in other image editors (e.g. Photoshop).

Photomatix supports the three most popular working spaces:

« sRGB: Use if the images are created only for the web.

- Adobe RGB: Popular working space for printing if extremely saturated colors are not used.
«  ProPhoto RGB: Wide gamut working space. This should never be used for 8-bit images.

For all JPEG and TIFF files, Photomatix Pro preserves the color spaces of the source files.

Photomatix Pro User Guide
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Glossary

AEB Mode

Aperture Priority

Bit
Bit Depth
Bracketed images

Chromatic Aberration

Contrast Ratio

dSLR

Dynamic Range

EXIF

Exposure

Exposure Fusion

EV (Exposure Value)

(Automatic Exposure Bracketing). DSLR cameras and some compact digital cam-
eras offer this feature. It enables you to automatically take three or more expo-
sures in a row: one at the proper exposure, one or more underexposed, and one
or more overexposed.

In Aperture Priority mode, you select the aperture and the camera determines
the correct shutter speed for the available light. The shutter speed also depends
on ISO sensitivity. This is the right mode for shooting bracketed shots for HDR
(refer to Section 1 for more information).

Bits represent digital data in computers. Digital Images are made of bits. A bit
depth corresponds to 2A(Bit Depth) levels (e.g. 256 for 8-bit).

The number of bits a file type uses to represent a pixel's color at a given location
in an image.

A group of photos taken with the Automatic Exposure Bracketing function of a
camera, resulting in photos of the same scene taken with different exposures

As the lens focuses different wavelengths slightly differently, chromatic aberra-
tion occurs. For example, the purple fringing you often find around edges (leaves
in front of a bright sky).

Another way to describe the dynamic range of a scene. The ratio between the
darkest and brightest areas.

Digital Single Lens Reflex camera.

In the context of HDR photography, the total range of light in a scene, from the
deepest shadows to the brightest highlights.

The Exchangeable Image File header contains information about the image, the
camera, location, date and time and camera settings.

The amount of light that enters a camera for the length of time the shutter is
open. Exposure depends on aperture and shutter speed, as well as the camera’s
sensitivity to light (controlled by the ISO). An exposure is also shorthand for a
photograph or frame (refers to a frame of film).

Combination of photos of the same scene taken under different exposure set-
tings in such a way that highlight details are taken from the underexposed pho-
tos and shadows details from the overexposed ones.

A measure of exposure which is the equivalent of a stop. In the absolute sense,
EV is defined as the exposure from a photo taken at 1 second, f/1, and ISO 100.
In the relative sense, the correct exposure is normally 0 EV and any deviation is
measured in positive or negative EV from that mark.
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HDR

HDR Image

Histogram

JPEG

Noise

Pixel

PPI

RAW File

TIFF

Tone Mapping

High Dynamic Range.

Strictly speaking, an HDR image is an intermediary image with 32 bits per color
channel (96 bits per pixel). An HDR image is the result of merging photos of the
same scene taken under different exposure settings and stored in special HDR
image format. The 32-bit intermediary HDR image must be processed with tone
mapping for proper display on standard monitors and prints. It has become
very common to define "HDR image" as the result of processing the 32-bit HDR
image with tone mapping, i.e. the tone mapped output, but this is not techni-
cally correct.

Histograms represent brightness distribution in digital images. They help evalu-
ate correct exposure. The y-axis represents the amount of pixels and the x-axis
represents the brightness value.

A common image file format with two primary strengths - a relatively small file
size and universal compatibility. JPEGs use a lossy compression scheme and
should not be edited and re-saved.

Statistical variations inherent in the sensor system cause noise. Noise is always
present, but higher sensitivities and smaller sensors usually generate more
noise.

Digital pictures consist of pixels, the smallest units. Each pixel has a color that
can be represented by 8 or 16 bit or as a floating-point number (32bit HDR).

Pixels per Inch. Can be used to describe the actual pixels per inch of a print. Of-
ten confused with DPI (Dots per Inch), used by color printers to print an image.

A file containing the raw data from the camera sensor. RAW files do not have a
color profile or other stylistic preferences permanently applied.

A comprehensive image format that offers lossless compression schemes for
smaller file sizes with higher quality. This format is suitable for editing and
printing but not publishing on the Web.

Processing a 32-bit HDR image into an image that can be properly viewed on
monitors and prints.
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Resources

You can find more tips, techniques, and regularly updated information in the Photomatix Pro FAQ on the HDRsoft
website at http://www.hdrsoft.com/support/faq_photomatix.html.
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